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Introduction to the user manual 

elcome to the SmileMS user manual.  

In this manual we will guide you through installing SmileMS and introduce you to 
its major functions. The innovative, robust algorithm allows you to identify 

molecules with the highest level of confidence. The intuitive graphical interface helps you 
running analyses in a few clicks. You can then go on to evaluate the results using several 
different views and easily generate a comprehensive report. The universality of SmileMS 
offers the possibility to handle data from different instruments and vendors with one 
software. Spectral libraries from various sources can be searched and you can build your 
own. 

For any further information or help, please contact us at smilems@genebio.com. 

 

 

  

Chapter 

1 
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Notices 

SmileMS is developed by Geneva Bioinformatics (GeneBio) SA. 
All intellectual property rights on SmileMS belong to GeneBio. 
 
Copyright © 2010 GeneBio – All rights reserved. 
GeneBio 
25 Avenue de Champel, CH-1206 Geneva, Switzerland 
 
 
SmileMS uses a number of following third parties software, including: 
 
ProteoWizard: Copyright © CAMM 

Open Source Software for Rapid Proteomics Tools Development 
Darren Kessner; Matt Chambers; Robert Burke; David Agus; ParagMallick 
Bioinformatics 2008; doi: 10.1093/bioinformatics/btn323 

 
Tomcat: Software developed by the Apache Software Foundation 

(http://www.apache.org). Copyright © 1999–2010 The Apache Software Foundation 
– All rights reserved. 

 
Flex: Copyright © 2010 Adobe Systems Incorporated – All rights reserved 
 
Postgres: Copyright © 1996 – 2010 PostgreSQL Global Development Group 
 
Spring: Copyright © 2010 (http://www.springsource.org/) 
 

 

Other Copyright or trademark notices for products mentioned in this document 

Windows is a trademark of Microsoft® 

AdobeAcrobat Reader is a trademark of Adobe Systems Inc. 

Adobe Flash® Player is a trademark of Adobe Systems Inc. 

Firefox is a trademark of Mozilla Foundation 

Xcalibur ® is a trademark of Thermo Fisher Scientific Inc. 

Analyst® is a trademark of AB SCIEXPte. Ltd. 

MassLynx™ is a trademark of Waters Corp. 

 
 

  

http://www.apache.org/
http://www.springsource.org/
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User manual 

What is SmileMS? 

Mass spectrometry is a recognized powerful analytical technique used to screen and identify a 
wide range of chemical compounds. It is used routinely in many laboratories in fields such 
as Laboratory Medicine, Forensic Toxicology, Doping Control, Food Testing, and 
Metabolomics research. The rapid introduction of LC-MS and LC-MSMS provides access to 
an extended range of molecules, complementing the well-established GC-MS methods.  

Current identification methods for both targeted and unknown screening increasingly rely on 
MSMS spectra library searches. A number of challenges are however still to be addressed. 
Fragmentation spectra of a given compound can vary a lot depending on the selected 
instrument and acquisition method. Currently available MSMS spectral libraries do only 
cover a subset of these experimental conditions for the available molecules. Algorithms 
offered in dedicated software solutions originate from the GC-MS development and do 
not show appropriate performances for LC-MSMS data. In addition, as this method is 
entering routine applications, there is a need for a robust, easy to use, MS vendor-
independent and integrated solution for rapid screening of large sets of molecules with 
high confidence. 

 

 
SmileMS meets these needs and proposes a unique LC-MSMS library search solution thanks to 

the following key benefits: 

Intuitive: Highly intuitive interface for rapid routine analysis and comprehensive 
results review 

Its intuitive interface makes it appropriate for routine applications of small molecule 
identifications and allows experts to evaluate the results in detail. Results are delivered in 
aggregated lists of identified analytes, supported with chromatogram and annotated 
spectra. 

Reliable: Powerful library search capabilities delivering highest level of 
confidence 

SmileMS is designed to identify analytes from MS spectra of fragmented molecules via a 
spectral library search approach. It can be used both for targeted and untargeted 
screening methods. Its robust and innovative algorithm allows for confident identification 
of molecules across different instrumental architectures and acquisition methods. 
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Versatile: One single software for multiple MS instruments, libraries and 
application fields 

The software can handle MSMS and MS3 data from a wide range of MS vendors, providing a 
single entry point for a battery of heterogeneous instruments. A large range of spectral 
libraries can be uploaded and queried simultaneously or separately, as provided by NIST, 
AB SCIEX, Wiley-VCH, etc., as well as privately created. SmileMS has been already 
successfully introduced in Clinical and Forensic Toxicology, as well as Food Testing. Its 
extension to other fields of Laboratory Medicine, Environmental, Pharmaceutical and 
Metabolomics is therefore independent from the tool itself. 

SmileMS is developed by GeneBio in collaboration with the Swiss Institute of Bioinformatics 
and the Department of Laboratory Medicine of the Geneva University Hospital in 
Switzerland. 

How to cite SmileMS? 

The algorithm imbedded into SmileMS has been published. This publication can be used to cite 
SmileMS: 

SmileMS (Geneva Bioinformatics) S.A.:  

Roman Mylonas, Yann Mauron, Alexandre Masselot, Pierre-Alain Binz, Nicolas Budin, Marc 
Fathi, Véronique Viette, Denis F Hochstrasser and Frederique Lisacek. X-Rank: A robust 
algorithm for small molecule identification using tandem mass spectrometry. Analytical 
Chem. 2009 Sep 15;81(18):7604-10 

Systems Requirements 

SmileMS is a client server application. Here are the prerequisite requirements for a SmileMS 
server: 

- Intel Dual Core CPU 
- 4GB RAM, 1.5GB disk space for installation. For optimum use of SmileMS allow 

at least 300GB 
- Windows XP (SP2 or SP3), Windows Vista, Windows 7 (32 bits version), Adobe 

Acrobat reader 
 

The SmileMS Graphical User Interface is a web-based interface. You will access it using a web 
browser. Supported web browsers are: 

- Firefox 3.5.0 and later, with Flash Player version 10 installed 
- Internet Explorer 7 and later, with Flash Player version 10 installed 

 
It is best displayed with a screen resolution of 1280x1024. 

Note: Your web browser will ask you to install Flash Player when opening SmileMS the 
first time, unless Flash Player is already installed. 
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Note: Adobe Acrobat Reader can be downloaded from http://get.adobe.com/reader/ 
(You do not need to install the optional Free McAfee Security Scan Plus). 

SmileMS installation 

SmileMS is designed as client-server architecture so that it can be installed as a standalone 
program on any PC or on a server for network access by multiple users. Remote access is 
therefore possible via a standard Web browser, giving users the freedom to launch 
analyses and review results from other locations (e.g. office, home, etc.). 

Install the SmileMS server and raw data module 

The installation procedure of the full SmileMS environment implies the installation of the 
SmileMS server itself, and installation of the raw data processing environment. The latter 
installs the needed software that allows you to submit native files from various MS 
vendors. The installation can be done from the installation CD or from the downloaded 
archive as follows:  

From the installation CD: insert the CD and follow the instructions from the index.html file that 
you are required to open in Internet Explorer. To do so, right-click on the index.html file, 
select "Open With" and choose Internet Explorer. From a downloaded package: unzip the 
SmileMS_installation_package.zip file in a local directory, open the index.html file in 
Internet Explorer. To do so, right-click on the index.html file, select "Open With" and 
choose Internet Explorer. 

Note: To install SmileMS, you need to log in Windows with a user that has administrative 
rights on the computer. 

 

Note: The raw data processing environment uses the open source Proteowizard 
(www.proteowizard.org ) tool to extract peaklists from various vendors' raw data files. 
This software is packaged in an installer, made available for free, to facilitate its 
installation.  

        For Thermo users, the installation require to set windows Regional Settings to English 
(United States). Please see the installation instructions for more details 

 

Note: If you are using a Windows installation using non Latin characters, you need to 
make sure that your Windows regional settings are set to English (United States) before 
the installation process is started. SmileMS requires appropriate number formatting and 
specific regional settings to work properly.  

http://get.adobe.com/reader/
http://www.proteowizard.org/
http://www.proteowizard.org/
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          In Windows XP: Go to Start > Control Panel > Regional and Language Options; In the 
Regional Options tab, select "English(United States)". Go then to the Advanced tab; Select 
"Apply all settings to the current user and to the default use profile". Click OK. 

 

In Windows vista and seven it looks like this: 
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Restart the SmileMS server 

According to the installation instructions, the computer hosting SmileMS must be 
restarted at the end of the installation process. Moreover, an additional restart is 
also sometimes required: please restart your computer a second time if you fail to 
login SmileMS after the first restart. 

Configuration settings 

Optional settings for the installation of the SmileMS server 

During the installation of the SmileMS server, some of the configuration can be set manually: 

- data folder (to specify where do you want to store the SmileMS data) 

- web server port (proposed default port for the tomcat web server is 8081) 

- database port (proposed default port for the sql database is 5433) 

Note: the SmileMS data folder can be changed and set to a directory accessible on a local 
disk or on a mounted disk. It is independent to the SmileMS program folder and can be 
archived as such. This is however not sufficient to create a restorable SmileMS backup. To 
create a SmileMS full backup, please see the corresponding chapter.  

How to change the memory to allocate to SmileMS? 

You need to define how much memory to allocate to SmileMS.  

Go to Windows Menu Start > All Programs > SmileMS -> smstomcatw 

Click on the "Stop" button in the "General" tab. Select the "Java" tab, and you can increase the 
value in the "Maximum memory pool". The value should not exceed the RAM of your 
computer. Note that Windows 32 bit cannot allocate more that 1300 MB to Java: 1024MB 
is an appropriate value. Click "Apply" then select the "General" tab again and click on the 
"Start" button. Close the window. 

Network, proxy, firewall issues 

SmileMS can work as a standalone application on one computer (for instance a MS acquisition 
PC). If you want to use SmileMS on a network configuration, you may want to make sure 
remote computers can access the SmileMS server. Depending on the network, proxy and 
firewall settings on and around your SmileMS server, please check the following if 
SmileMS does not start correctly: 

- If you are using a proxy, define the access to SmileMS appropriately in all client 
browsers: On your browser, set the proxy detection to “autodetect”. On 
Firefox: go to Tools > Options, then select the Advanced option, choose the 
Network tab; Click on Settings… and select Auto-detect proxy settings for this 
network. On Internet Explorer: go to Tools > Internet options, then select the 
Connections tab, click on the LAN settings button and check the Automatically 
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detect settings option. Another option is to add the SmileMS server url in the 
exclusion list of the browser proxy settings. As some proxy definitions and 
constraints can be proxy configuration dependant, ask your IT. 

- Server firewall: Check the firewall installed on the SmileMS server. Open the 
8081 port (or the port defined at the installation). As this firewall might be 
defined in many ways, ask your IT. 

- If SmileMS is installed on a computer not connected to any network and you 
use FireFox as browser, Firefox will put itself in “offline mode”: This means you 
will not be able to connect to the SmileMS server from your browser. To 
bypass this, in Firefox, select “File”, and uncheck “Work offline”. 

What is installed by the SmileMS server installer? 

The SmileMS server installer installation process installs the following elements: 

- Java Runtime Environment 1.6 
- The SmileMS server itself 
- A tomcat web server 
- A postgresql database 
- Information in the computer registry 
- A SmileMS item in the list of programs available from the windows Start menu 

(Start > All Programs > SmileMS). It includes a link to SmileMS and a link to a 
SmileMS administration console, labeled smstomcatw, which is mainly used to 
start and stop SmileMS and to change its allocated memory. 

What is installed by the SmileMS raw data module? 

The installation of the SmileMS raw data processing environment includes the following 
elements (if not already there): 

- Microsoft Windows Installer (only necessary for Windows XP) 
- Microsoft .NET Framework 3.5  
- Microsoft Visual C++ 
- MSFileReader (useful only for Thermo users) 
- Proteowizard package 

What else needs to be installed to work with SmileMS? 

SmileMS is accessible via a web browser such as Firefox and Internet Explorer. This has to be 
installed on the computer you are using to access SmileMS.  

As the graphical interface is developed using the Flash technology, you need this browser to 
have an Adobe® Flash® Player installed. If it is not installed, you will be asked to install it 
via a hyperlink. You can get it from http://get.adobe.com/flashplayer/ 

 

As SmileMS can generate reports in pdf format, you need to have a pdf reader to view them 
(for instance Adobe® Acrobat Reader). 

http://get.adobe.com/flashplayer/
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How to uninstall SmileMS? 

Go to Start > Control Panel; double-click on the Add and Remove Programs icon; select 
SmileMS and remove the installation. 

Note:The uninstall procedure will erase the data folder. If you wish to keep the data, ask 
us how to do a backup of SmileMS content. The uninstall procedure will also remove the 
proteowizard installation. 

To uninstall the other modules, go to Start > Control panel; double-click on the Add and 
Remove Programs icon; select the modules and remove the installation. Be aware that 
some of these modules might be used by other applications already on your computer, 
and were installed prior to SmileMS installation. Removing them may cause other 
programs stop working. 

About SmileMS user types 

SmileMS allows two types of users who are allocated different rights and privileges: 

- Admin has the maximum rights. They can see results from all other users, they 
can administrate profiles, users and libraries, etc. 

- User has restricted rights. For example they cannot see jobs from other users, 
they cannot change filter values in results, they cannot create or modify 
profiles from other users and they cannot create or modify user profiles. 

Start and log-in to SmileMS 

There are two possibilities to start the SmileMS interface on a local computer: 

1. Start > All Programs > SmileMS -> SmileMS 

2. Open your preferred browser and type the url:http://localhost:8081/smilems 

You will arrive at the login page. Two users are predefined in SmileMS: username demo (no 
password) with user privileges, and username admin (password admin) with admin 
privileges. Additional user names and passwords can be defined by admin users. See the 
Administration section. 

 

Note: If you want to log in from a remote computer, ask IT for the IP address or the 
name of the SmileMS server. Use then this info and replace "localhost" in the url (for 
instance http://my_smilems_server:8081/smilems). Make also sure that the url is 
accessible (you might have to ask IT to open the firewall for connections to the 
SmileMS server) 

 

Troubleshoot: I cannot login to SmileMS  

http://localhost:8081/smilems
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- I have no network connection and I’m using Firefox: 
 If your computer is not connected to any network (you are therefore running 

SmileMS on a standalone machine) and you use FireFox as browser, it may put 
itself in “offline mode”. This means that you will not be able to connect to the 
SmileMS server from your browser. To bypass this, in Firefox, select “File”, and 
uncheck “Work offline”. 

- I want to connect to SmileMS from remote computer: neither Start > All Programs > 
SmileMS -> SmileMS nor http://localhost:8081/smilems does work. These 
connections are only valid for the computer where SmileMS is installed. If you want 
to log in from a remote computer, ask IT for the IP address or the name of the 
SmileMS server. Use then this info and replace "localhost" in the url (for instance 
http://my_smilems_server:8081/smilems). Make also sure that the url is accessible 
(you might have to ask IT to open the firewall for connections to the SmileMS server) 

- I get to the login page but I cannot connect:  
 The Tomcat server may be off. From the SmileMS computer, go to Start > All 

Programs > SmileMS ->smstomcatw and click on the start button. 
- I get the login page but I cannot connect (bis): 
 The smspostgres service may be off: go to Start > Control Panel > Administration 

tools > Services, search the smspostgres service and click on the start link. If it does 
not start, reboot your computer.  

- I get the login page but I cannot connect (ter). I run the SmileMS server with Panda as 
security software: 

 Check if the smspostgres service is on. If not, start it: go to Start > Control Panel > 
Administration tools > Services, search the smspostgres service and click on the start 
link. If it does not start, check if you can start pgadmin.exe (start c:\Program 
Files\SmileMS\ pgsql\bin\pgAdmin3.exe. If you get a message such as “could not 
locate libpq.dll” reinstall SmileMS (uninstall/reinstall). Make sure you have backed up 

the SmileMS data before reinstalling SmileMS. 
- I get a popup window with the following error message: "Server.Error.Request 0": 
 Refresh the page using the browser refresh button 
 
 

 
 

http://localhost:8081/smilems
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Once logged into SmileMS, you arrive at the Analysis List section. 

The Analysis workspace is one of the three workspaces offered by SmileMS. You can switch 
between the Analysis, the Library and the Administration workspace by clicking on the 
corresponding banner button. 

From all pages you have information on the logged user name and user type (in parentheses), 
access to an exit (log out) button and a help button which links to the user manual in pdf 
format. 

 

 

Start an analysis and get a pdf report 

You can start a new analysis and get a pdf report from the Analysis list page in the 
Analysis workspace. 

Start an analysis 

Select the new analysis button. 

 
 
A pop-up window opens. Complete with the required information and click on submit. The 

pop-up window closes and you can follow the status of the analysis on the Analysis list 
page. 
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The submission pop-up window asks you to: 

1. Select the file format from the Format drop-down menu (see also notes below); 

2. Click on Upload file to select the file(s) to upload (see the text describing what file(s) 
is/are needed and the notes below); during the upload, a progress bar appears next to 
the Upload file button; 

3. Select a submission profile from the Profile drop-down menu (see also notes below); 

4. Enter a description for the analysis (this depends on the file format); 

5. Once all set, click on submit.  

 
 
 

Note: About file formats: SmileMS directly processes peaklist files in various formats, 
such as mzXML, mgfand NIST sdf format). Raw, MS vendor-specific datafiles are 
submitted to a spectrum extraction step prior to the submission to SmileMS. This 
process uses the raw data module, which is part of the SmileMS installation. In 
addition, Waters MassLynx data requires that MassLynx is installed on the same 
computer as the SmileMS server. Processing raw data requires uploading one or 
more files, depending on the vendor format:  
    - AB SCIEX: a pair of .wiff and .wiff.scan 
    - Agilent: all files in the AcqData subdirectory of a .d directory 
    - Bruker: .xml peaklist file as generated by Data Analysis 
    - Thermo: .raw file 
    - Waters: all files in a .raw directory 

 
 

Note: About AB SCIEX multi-samples wiff files: One AB SCIEX .wiff file can contain 
multiple MS acquisitions (different runs, controls, washing steps, etc.). When you 
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have uploaded a pair of .wiff and .wiff.scan files that contain multiple samples, a new 
pop-up window appears that lists the samples. You can choose what sample(s) you 
really want to submit to SmileMS via the check boxes. The SmileMS analyses’ 
descriptions are pre-filled with the original .wiff filename and the samples’ 
descriptionsare entered as Analyst®. You can change these descriptions before 
confirming which analyses to submit to the identification process. 

 
 
 

Note: In cases you are submitting many jobs in a row, it might happen that the 
profile drop-down menu does not contain any item when the submission 
window pops up. This is due to the limited amount of connections to the 
SmileMS server allowed by your browser. Please wait for a few seconds until 
the profile items appear in the profile drop down menu. 

 

Note: Once the submit button is clicked, SmileMS first extracts peaklists from raw 
data and then launches the identification in a second step. The extraction step can 
take from few seconds to several minutes, depending on the size of the data file, the 
number of included fragmentation spectra and the number of stored individual 
samples. 

 
 

Follow the status of an analysis 

When raw files are submitted, spectra are first extracted from the vendor proprietary format 
before submission to the identification process. This is visible as a progress bar in the 
Analysis list page. 

 
 
Identification runs can have different progression statuses represented as a colored dot in the 

analysis list page:  
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- pending (orange),  
- running (blue),  
- completed (green),  
- failed (red) (click on the red dot to see the error message. 

 

 
 

 
 

The status is refreshed regularly (every 2 minutes). Click on the Refresh button to refresh 
manually. 

 
 

Generate a pdf report from an analysis 

From the Analysis list page, browse for the analysis of interest, and click on the pdf icon to 
generate and export a pdf report. 

 

 

 

The pdf report is divided into 4 sections: 

- A description of the analysis, the search criteria and the reporting filters 

- A chromatogram, annotated with the positions of the identified compounds 

- The Library Search Result: The list of the identified compounds 

- Identified Compounds: The matching spectra  
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For a more detailed description of the information displayed on the pdf report, see the “The 
pdf reports” section. 

The Analysis list page 

The analysis page is located in the Analysis workspace. It is a central page where you can start a 
new analysis, resubmit an analysis, view and search the list and status of already 
submitted analyses, ask to open one or more results. 

What information is available for each analysis? 

The Analysis page provides the list of analyses available to be reviewed by a user in a table. A 
user with user privileges will see only the analyses he/she has submitted. A user with 
admin privileges will see all analyses. You can sort the analyses by clicking on the 
corresponding column title. 

Each analysis is represented in a line, and annotated with the following information:  

- Id : a unique identifier attributed to this analysis; 
- File name: The name of the processed peaklist file submitted to SmileMS. 

When the analysis is successfully completed, click on the file name to open the 
result view in a new tab; 

- PDF: a link to the pdf report for this analysis; 
- # spectra: number of MSn (MS2, MS3, …) experimental spectra considered in 

the identification process; 
- Description: Description of the analysis; 
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- Date uploaded: Date when the analysis was submitted; 
- Status: Status of the analysis; 

Owner: name of the user who submitted the analysis (only available for admin users). 

Display/hide analyses 

Hide analyses from the list. Select one or more analyses (use the checkbox) and choose hide in 
the Action drop-down menu to remove them from the list. 

Show hidden. Click on the show hidden check box to display all analyses. 

Unhide analyses. Once the Show hidden check box is activated, you can select one or more 
analyses and choose unhide in the Action drop-down menu to let them reappear in the 
list. 

You can choose how many analyses you wish to see displayed per page.  

 

Search analyses 

The search functionality allows you to restrict the list of displayed analyses to those matching 
the search criteria. The search is applied to the Description and the File name fields. 

Perform a resubmission 

You can select one analysis and decide to resubmit it on another library and/or using different 
search stringencies. As these criteria are defined in profiles, a resubmission means apply a 
search on a dataset using another profile. 

Select one (and only one) analysis; choose resubmit from the Action drop-down menu. A pop-
up wind opens where you can choose to select a new profile and change the Description. 
By default, the proposed description is “Resubmission (job nn)” where nn is the analysis ID 
to be resubmitted. 

 



 

SmileMS user manual  v1.2, May2011 20 

 

 

Evaluate a result 

Open a result, general description of the result page elements 

Clicking on a result file name from the Analysis list page will open the result in a new tab. The 
result page displayed by default contains the following elements: 

- Descriptive information about the analysis (analysis identifier Id, Submission 
Filename, Analysis Description, Selected submission Profile, Submission Date); 
Mouse over a description to read a long text; long texts are cut to 255 
characters; 

- Actions on the result. Tolerance filters on molecular ion m/z and elution time 
RT filters on Polarity and MS level ; Show unidentified spectra check box; result 
pdf export icon;  

- Chromatogram; 
- Table of matched chemical compounds. 
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The spectrum viewer element can be displayed by clicking on the spectrum viewer button or 
the vertical bar with a “+” on the far right part of the page. The spectrum viewer contains 
three elements: 

- The spectrum match graph, 
- The spectrum match annotation info tab, 
- The Additional matches tab. 
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Evaluate a result 

The Table of matched chemical compounds 

The list of identified molecules is available in the Table of matched chemical compounds. Each 
molecule is represented with: 

- its Chemical compound name,  
- a colored label to situate it on the Chromatogram,  
- the number of experimental spectra matching this compound (# Hits). 

 

Additional columns display information on the best matching spectrum:  

- the Score,  
- the experimental retention time (Exp. RT),  
- the retention time of the corresponding spectrum in the library (Ref. RT),  
- the retention time difference between Exp. RT and Ref. RT (Delta RT),  
- the experimental molecular ion m/z (Exp. m/z),  
- the molecular ion m/z of the corresponding spectrum in the library (Ref. m/z),  
- the m/z difference between Exp. m/z and Ref. m/z (Delta RT), 
- The polarity and MS level for both reference and experimental spectra 

(Ref/Exp), 
- A few columns are hidden when the spectrum viewer is displayed. (+2/+3 

means that Ref. spectrum is a positive MS2 and Exp is a positive MS3). 
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As a Chemical compound can be identified with more than one spectra (# Hits> 1) click on the 
“+” button to view details on all matching spectra for the selected compound. This will 
expand the compound with additional lines, one per matching spectrum. Click on the “-“ 
button to hide the details. 

Some columns of the table can be sorted. Click on the column title to sort them. 

 

Note: SmileMS calculates a score based solely on spectrum comparison. Its 
calculation is based on a log-likelihood ratio, which means that it estimates the 
probability that a spectral match is not random/false. Filters such as molecular ion 
m/z tolerance and Retention time tolerance are applied as post processing to the 
score calculation. The scores in SmileMS range from 0 to 1. 1 is the highest value. 
These score values represent quality of match and are related to probabilities of 
being correct. Acceptable thresholds for high-quality matches may vary depending 
on the instrument, instrument acquisition parameters, library content and your own 
stringency acceptance levels. According to the SmileMS algorithm that calculates 
probabilities of correct matches, compounds displaying only a few signals (3 peaks or 
less) might never get a high score, as the intrinsic “chance” of matching a random 
spectrum is increased compared to a richer spectrum and thus, the probability of 
being wrong is increased based solely on the spectral matching. Therefore, applying 
molecular ion m/z filter and RT filter can be useful to validate those more difficult 
compounds. 

 

The Chromatogram 

The Chromatogram displays MS or MSMS signal intensity as function of Retention time in 
minutes. Identified spectra are labeled with colored spots. Each spot corresponds to an 
individual fragmentation full-scan spectrum. Its color is associated with a Chemical 
compound as displayed in the Table of matched chemical compounds. 

Functionalities of the Chromatogram: 

The Chromatogram has two main interaction modes: the browse mode and the zoom mode. 
You can switch from one mode to the other by selecting the hand or the magnifier button 

on the, respectively ( ). The default mode is the browse mode 

In the browse mode ( ), place your mouse over a spot to open a pop up window with 
matching information. 
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Click on a spot to enlarge all spots of that compound, to add a square to that particular spot, to 
show the corresponding match in the Table of matched chemical compounds, and if the 
spectrum viewer is open, to show the spectrum match details. 

 
 

Zoom: activate the zoom function (magnifier button). Drag over the region you want to zoom 
in. Double-click on an empty region or click on reset zoom to zoom out to original 
Chromatogram. 
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The Y rescale button, when active (default) allows automatic rescaling of the Y axis of the 
zoomed Chromatogram at all magnified states to the max y value of the current zoomed 
in region. Inactivate it to leave the y axis scale to the full Chromatogram range. 

 
 

Show unidentified spectra: select the corresponding check box and click on the apply button to 
display all fragmentation spectra acquired in the analysis. They will be shown as grey 
spots. 
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Note: The chromatogram is created from the information available in the extracted 
peaklist files. Each point of the chromatogram represents one MSMS scan. The time 
of the acquisition is on the x axis and the associated intensity is either the intensity of 
the precursor ion in the respective precursor spectrum or the TIC of the actual scan. 
Therefore the chromatogram can be very similar or very different to a MS1TIC or 
BPC, depending on the acquisition conditions, criteria and information delivered in 
the extracted peaklist file. 

 

The Spectrum viewer 

To open/close the spectrum viewer, click on the spectrum viewer button or on the vertical bar 
(with the “+” or “-“ buttons) on the far right side of the page. 

Once you have selected a spectrum match, either clicking on a spot on the Chromatogram or 
on a line in the Table of matched chemical compounds, you can see a head to tail 
representation of a spectrum match. The experimental spectrum is shown on top and the 
reference spectrum (from the library) is shown on bottom. X axis is a m/z scale and y axis 
represent signal intensities with values normalized to 1 on both axes.  

Functionalities of the spectrum graph: 

- Put your mouse over a peak to see its annotation. Actual intensities are 
labeled.  

- Zoom in by dragging a region on the graph. Use the Y rescale button to 
automatically rescale the y axis of the spectrum to local maximum value. 
Double-click on an empty region or click on reset zoom to zoom out to original 
graph. 
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The Info tab provides annotations to experimental and reference spectra, such as Spectrum 
name, Molecular ion m/z, Precursor m/z, Retention time (in min), Polarity, MS level, 
Chemical compound name, Chemical Abstracts CAS, Synonyms, Source Library name. A 
link to NCBI PubChem Compound database (http://pubchem.ncbi.nlm.nih.gov/) will 
search the database with the Chemical compound name and open the result in a new 
browser window. This functionality is searching via internet and is only available if you 
have access to Internet. Admin users have access to edit buttons that allow to either add 
an Experimental Spectrum to a library or to modify the annotation for a Reference 
Spectrum. 

 

 
 

To add an experimental spectrum to a library (functionality restricted to admin users) 
- Click on the edit button at the bottom of the Experimental spectrum column. The 

editable fields are displayed in individual boxes. These are pre-filled with information 
related to the spectrum. Some values are rounded in the normal display, such as 
molecular ion m/z, precursor m/z, Retention time, Intensity. The complete value is 
visible in edit mode. The name of the corresponding compound is automatically 
filled. You can select the name of an existing library where the experimental 
spectrum and its annotation will be saved. 

 

http://pubchem.ncbi.nlm.nih.gov/
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- Once you have finished the edition, click on the save button. The information will come 

back to the original information and a popup windows tells you that the edited 
spectrum is saved in the selected library 

 

Note: If you want to add a spectrum to a new library, you have first to create an 
empty library in the library management and then add the spectrum to this newly 
created library. 

 

Note: The fields CAS and Synonyms are associated with a chemical compound and 
can only be edited in the library details view page. 

 
 
To modify the annotation of a library spectrum (functionality restricted to admin users) 
- Click on the edit button at the bottom of the Reference spectrum column. The editable 

fields are displayed in individual boxes. These are pre-filled with information related 
to the spectrum and the associated compound. Some values are rounded in the 
normal display, such as molecular ion m/z, precursor m/z, Retention time, Intensity. 
The complete value is visible in edit mode. You can decide to change the information 
(adjust the molecular ion, adapt the Retention time to new chromatographic 
conditions,  
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- Once you have finished the edition, click on the save button. The information will come 
back to the original information and a popup window tells you that the edited 
spectrum is saved in the selected library. 

 

Note: The fields CAS and Synonyms are associated with a chemical compound. Be 
careful when changing this information as it will impact all other spectra associated 
with the same compound name in the library. 

 

The Additional matches tab provides information on alternative interpretations for an 
experimental spectrum. Alternative spectra are displayed with the Chemical compound 
name and matching score. This indicates whether there is a unique interpretation of a 
given spectrum, or if there are potentially conflicting interpretations. 

 
 

          Left: A good match, 3 spectra in the library matching Zolpidem only; Right: a bad match, 
lower score best match, two conflicting molecules. 

Using the filters bar 

Functions available on the bar above the chromatogram and spectrum viewer can be used to 
“manipulate” a result, i.e. to increase/decrease the tolerances applied to precursor m/z 
and RT windows as well as browsing through unidentified spectra. Typically, this may help 
to identify low scoring molecules, adducts, metabolites of molecules in the library and add 
new spectra in a library. 

 
The m/z, RT, Polarity and MS level filters: These filters can increase or decrease the stringency 

of the result. By default, the values displayed for these filters are those of the submission 
profile. You can change these values. Click on apply to activate the function. Unchecking 
the check boxes will inactivate the corresponding filters. Comment: a negative filter value 
is equivalent to an inactive filter. 

 

Note: m/z, RT, Polarity and MS level filters functionality is available to admin users 
only. Regular users cannot change these values. For them the checkboxes are not 
available and the values are displayed in a grey background. 
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The Show unidentified spectra functionality: Click on the check box and validate on the apply 
button to display all unidentified spectra on the chromatogram. These are highlighted as 
grey spots behind the chromatogram trace. 

 
In the spectrum viewer the unidentified spectra are displayed with no reference spectra graph 

and annotation (as there is no matching spectrum in the searched library for these). 

An unidentified spectrum can be edited and added to a library (functionality only available to 
admin users). The mechanism is similar to the edit mode for identified spectra (see 
above). In the case of a spectrum that was not identified, a “-“ replaces the name of the 
compound. The column reference spectrum remains empty. 

 

Generate reports from the results page 

Click on the pdf icon on the filter bar to generate a report of the current result. You have the 
choice between a standard report and a full report: 
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- The standard report provides a header with general information about the 
analysis, a chromatogram, a table listing the 
identified compounds (and corresponding 
information for the best matching spectra) and for 
each of them the corresponding pair of experimental 
and matching spectra. The full report contains the 
same information as the standard one and adds 
detailed information about all matching spectra for each compound. 

The results pdf reports 

Here is a description of the information displayed in the pdf reports that can be generated from 
the Results page and from the Analysis list page. Two types of PDF reports can be 
generated: The Standard PDF and the Full PDF. 

1) Standard PDF: This report displays the list of the identified chemical compounds, a 
representative chromatogram and spectral match details for each best matching 
spectrum per compound and MS level, for a given analysis. It is the default report 
available from the Analysis page and the one named “Standard PDF” in the result 
page. This report is a multi-page report stored in an Adobe Acrobat PDF format. It is 
divided into four sections: 

a) A description of the analysis, the search criteria and the reporting filters 
b) A chromatogram, annotated with the positions of the identified compounds 
c) The Library Search Result: The list of the identified compounds 
d) Identified Compounds: The matching spectra (the best matching spectral pair for 

each compound) 
 

…other spectra pages 
Further details of the four sections: 

a) A description of the analysis, the search criteria and the reporting filters:  

a. Information about the Sample and submitted MS run: SmileMS JobID (Job ID 
in the SmileMS server), File Name (name of the converted MS run submitted 
to SmileMS), Date (of the submitted analysis), Sample Description, # spectra 
(number of considered individual spectra). 
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b. Information about the submission criteria and the reporting filters: Profile 
Name (name of the submission profile), Library (name of the library/libraries 
queried), Score threshold, Min # peak matches, Prec tolerance [Da]  (m/z 
tolerance on the molecular ion as set in the profile), RT tolerance [min] 
(retention time tolerance as set in the profile), MS level filter (as set in the 
profile), Polarity filter (as set in the profile), Report m/z filter [Da]  (m/z 
tolerance on the molecular ion as set in the result page), Report RT filter [min] 
(retention time tolerance as set in the result page), Report MS level filter (as 
set in the result page), Report Polarity filter (as set in the result page) 

b) A chromatogram, annotated with the positions of the identified compounds: the 
identified compounds are represented with an index number and placed at the 
position of the best matching spectra. 

c) The Library Search Result: The list of the identified compounds: This table displays each 
compound in one line. The columns are: # (index number; this number is used to find 
the compounds on the chromatogram), Chemical Compound (name of the compound 
as stored in the library), Score (the best matching score for this compound), # Hits 
(number of individual spectra matching this compound), Exp RT (experimental 
retention time, in minutes, of the best matching spectrum for this compound), Delta 
RT (Retention time difference between the value in the best matching spectrum and 
the corresponding value annotated for the reference spectrum), Exp m/z 
(experimental molecular ion m/z of the best matching spectrum for this compound), 
Delta m/z (m/z difference between the value in the best matching spectrum and the 
corresponding value annotated for the reference spectrum), Intensity (Intensity 
associated with the best matching experimental spectrum) 

d) Identified Compounds: The matching spectra. For each identified compound, The 
name of the compound is shown, followed by a table that recalls information from the 
corresponding line in the Library Search Result table.  For the represented spectrum, 
Score, Exp. RT, Delta RT, Exp. m/z, Delta m/z and Intensity are shown.  This is followed 
by a pair of spectra, representing the corresponding experimental spectrum (on top) 
and its best matching reference spectrum (on bottom) for each MSn level. The 
respective spectrum titles are displayed and information on experimental and 
reference MS level and polarity is shown.  

 

2) Full PDF: This report displays the list of the identified chemical compounds, a 
representative chromatogram and spectral match details for ALL matching spectra per 
compound, for a given analysis. It is the report named “Full PDF” in the results page. 
The first 3 sections are the same as in the Standard PDF report. The last section 
(Identified Compounds) includes not only one spectral pair per compound for each 
MSn level but all pairs of spectra identifying the listed compounds. The tables in the 
Identified Compounds section include as many lines as there are experimental spectra 
matching the corresponding compound; for each of them there is a graphical 
representation of a matching pair. This report can be very large and may take several 
minutes to generate. 
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-  

Visualize, modify, export and create spectra libraries 

The Library workspace allows you to install new libraries, to visualize the content of a library 
(compounds, spectra, spectra annotation), to modify the content of a library (compound 
name, spectra annotation) and to export library contents. 

 
 

Open a library 

In the Library list page, the list of installed libraries is shown in a table format. Each installed 
library is represented in a line with its Name, its Description, the number of chemical 
compounds and the number of spectra it contains. Click on a library name to get more 
details about this library. This opens a new tab labeled with the name of the library. 

Visualize a library entry 

Once you have opened a library tab, you can browse the content of the selected library. The list 
of the chemical compounds is displayed in a table. Each compound is represented in one 
line with its name and the number of spectra the library contains for that compound. The 
list can be sorted by clicking on the Chemical compound column title. 

To visualize more details about one compound, click on a compound name. The compound is 
expanded and one line per spectrum is displayed with Spectrum name, molecular ion m/z 
and MS Level.  

Clicking on a spectrum name opens a spectrum viewer that displays the actual spectrum and 
additional annotation information (such as Spectrum name, Molecular ion m/z, Precursor 
m/z, Retention time (in min), Polarity, MS level, Chemical compound name, Chemical 
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Abstracts CAS, Synonyms). A link to NCBI PubChem Compound database 
(http://pubchem.ncbi.nlm.nih.gov/) will search the database with the Chemical 
compound name and open the result in a new browser window. This functionality is 
searching via internet and is only available if you have access to Internet. Click on the 
PubChem link queries the NCBI PubChem Compound database 
(http://pubchem.ncbi.nlm.nih.gov/) with the name of the Compound and opens a new 
window with the results of the query. This functionality is searching via internet and is 
only available if you have access to Internet. 

 
 

Modify a library entry 

You may need to change a spectrum annotation in a library, such as adjusting the Retention 
time to your experimental conditions. You can change information about a compound in a 
library if you are a user with admin privileges. Click on the edit button, make your changes 
in the editable fields (Spectrum name, Molecular ion m/z, Precursor m/z, Retention time 
(in min), Polarity, MS level, Chemical compound name, Chemical Abstracts CAS, Synonyms, 
Source Library name) and click on the save button to store the changes. All future queries 
to this library will consider the new values.  

http://pubchem.ncbi.nlm.nih.gov/
http://pubchem.ncbi.nlm.nih.gov/
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As you can add multiple synonyms to a compound, a dedicated pop-up window opens when 
you select to edit the Synonyms field. 

 
 

Note: Most of the annotations are associated with a spectrum (Spectrum name, 
Molecular ion m/z, Precursor m/z, Retention time [min],MS level, Polarity). However, 
information such as Chemical compound, CAS number and Synonyms is associated 
with a chemical compound. Therefore, when one of these fields is edited, this is 
reported to all spectra belonging to the same Chemical compound. 

 

Export a library 

You can export the list of compounds and the number of associated spectra in pdf format. 
From the library tab, click on the pdf icon. 

You can export a complete library in SmileMS xml format. Click on the Export button. This 
functionality is restricted to admin users. 
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Upload/create a new library 

As user with admin privileges, you can import a spectrum library into SmileMS or create a new, 
empty library and add manually spectra to it. 

Note: To search this newly installed library, don’t forget to associate it with a profile. 
See the section “Search the newly installed library” at the end of this section  

 

In the Library list window, click on the new library button to prepare for the installation of a 
new library. A pop-up window appears for you to enter a Name and a Description. While 
creating a library, you can choose to add spectra to this library by importing data from a 
library file or to create an empty library and then add spectra manually from the result 
pages. If you want to create an empty library select no; 

 

 
 

 
A pop-up appears that says the library is created. You can add experimental spectra to this 

library from the edition fields in the results pages. See the Spectrum viewer section for 
more details. 

If you want to import spectra to the newly defined library select yes; 
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You are asked to upload a library file. Browse your computer for the library to be imported and 
click Upload library file. Once uploaded, click on create to create the library in SmileMS.  

 

 
 

A progress bar appears and the interface is blocked for other actions during the library 
preparation step. This might take a few minutes or up to over an hour, depending on the 
number of spectra in the library to upload. At the end of the process, a completion pop-up 
window appears, containing the name of the library and the number of stored spectra. 
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The library is then visible in the Library list page. It is then ready to be visualized and to be 
added to a submission profile. 

Note: SmileMS can read the following formats: 
           - AB SCIEX .clq format and Analyst .mdb library 
           - Bruker .library format 
           - NIST .sdf (when uploading a .sdf file, you will be prompted to choose between a  
regular NIST .sdf format or a Maurer sdf format (.sdf format with specific fields to the 

Maurer LC-MSMS library). 
           - SmileMS XML library format 
Other formats can be converted into one of the above using export functions from your 

preferred Acquisition software or using the nist2lib.exe program as available in the 
NIST MSSEARCH software package. 

 

Note: SmileMS does not query and therefore does not store MS1 spectra in its 
database. Only spectra labeled with a MS level 2 or higher are imported in SmileMS.  

 

Troubleshoot: The library installation never ends: the screen remains for ever with the 
progress bar and does not pop up the finished window. 

        -  The installation is still running. Some libraries might need long installation time (up 
to 3 hours for NIST_MSMS depending on your computer. Just wait longer. You can 
alternatively also open the windows task manager and see if a postgres.exe process 
is running 

        -  The installation went out of memory. Stop the smstomcatw service and increase 
the memory allocated to Java (see section “How to change memory”). 

 

Search the newly installed library 

In order to search the newly installed library, it needs to be defined in a profile. Go to the 
Administration > Profile manager section and either create a new Profile that searched 
this library or replace/add this library to an existing profile. See more details in the Profile 
manager section in the Administration page chapter below. 
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Install a NIST binary formatted library 

This section describes how to convert a library in a NIST binary format into a SmileMS readable 
format and to install this library in SmileMS. 

Prerequisites 

The prerequisites for the procedure are: 

- A SmileMS server already installed 
- lib2nist.exe application that is part of the NIST MSSEARCH software package 
 

 

Overview of the procedure 

The update procedure consists in: 

- Convert a library from a NIST binary format to a .SDF format  

- Import this converted library to SmileMS 

- Add this library to a submission profile 

 

The procedure 

Convert the NIST binary formatted library to a .SDF format 

1. Open lib2nist.exe. The program is by default in  

C:\Program Files\NISTMS\MSSEARCH directory 

 

2. Select the library to convert, click Open 

 



 

SmileMS user manual  v1.2, May2011 40 

3. Select the library in the Convert MS Libraries or Datafiles to NIST or HP JCAMP Format 
window; make sure that the options include the following checkboxes: Include synonyms, 
Keep IDs unchanged, MS/MS spectra only. 

 

4. Select SDFile (.SDF) as output format 

5. Click on Convert 

 

6. The converted .sdf file is located in the same directory as the source file. 

 

Upload the converted library to SmileMS 

7. In SmileMS log in as user with admin rights (for instance the default admin user) 

8. Go to the Library workspace 

9. Click on the button New library, give a name, a description, and select yes to the 
question “Do you want to import spectra from a library file?” 
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10. Upload the newly created .SDF file 

11. Click on create. The upload might take a few minutes to more than two hours, 
depending on the format and the number of spectra in the library. 

12. At the end of the process, a pop-up window appears that provide the number of 
spectra imported for this library 

 

Add the library to a submission profile 

To search the library with SmileMS you need to associate it with a submission profile. 

13. Go to Administration > Profile manager 

14. click on the New profile button to create a new one or select an existing profile to edit 
it 
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15. Edit the information. Drag the library (libraries) to be searched from the Available 
library to the Selected library boxes 

16. Click on Update. The submission profile is available from the new analysis function. 

 

Administration page 

Users 

The user management system is the part of the administration workspace that allows to:  

- List existing users, 
- Update user definitions (Password, First name, Last name, Email address, 

Default format, Default profile), 
- Add new users. 
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Note: Users can define a default format. This is the data format that is by default 
selected when starting a new analysis from the Analysis list page (Peaklist, AB Sciex, 
Agilent, Bruker, Thermo, Waters). 

 

Note: Users can define a default profile. This is the profile that is by default selected 
when starting a new analysis from the Analysis list page. Default profiles are used in 
various integration processes. Typically, they are used to ensure the use of a unique 
profile throughout technicians of a laboratory. 

 

Note: administrators can access all functions, whereas standard users can only view 
and modify their own parameters. 

 

Profiles manager 

The profiles manager is the part of the administration workspace that allows you to manage 
submission profiles. A submission profile is a set of parameters that SmileMS uses to 
perform identification. This includes for instance the library to search, the tolerances to 
apply to molecular ion m/z and retention times, minimal score threshold. The profile 
manager window allows to: 

 
- List and modify existing profiles, 
- Add new profiles. 
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Note: administrators can see and edit all profiles whereas standard users can only 
edit their profiles. They can however see and use their profile as well as shared 
profiles. 

 

Click on the New profile button to create a new profile or click on an existing one to edit it. 

When creating a new profile or modifying an existing one, users can enter information 
regarding: 

1. Profile Name 
2. Profile Description 
3. Shared profile : makes this profile visible to all users. 
 
4. Precursor tolerance [Da]: this value limits scoring results to those having a 

precursor m/z difference above this threshold. This filter can be deactivated 
using the corresponding checkbox. 

5. Retention time tolerance [min]: this value limits scoring results to those 
having a retention time difference above this threshold. This filter can be 
deactivated using the corresponding checkbox. 

6. Polarity filter: this value limits scoring results to those with experimental and 
corresponding spectra having the same polarity 

7. MS level filter: this value limits scoring results to those with experimental and 
corresponding spectra having the same MS level (i.e. both MS2, both MS3) 

8. Scoring: choose between a standard scoring that performs matching with low 
mass accuracy fragmentation spectra; and a scoring that performs matching 
with a high mass accuracy filter for the fragmentation spectra. The 
corresponding tolerance is given in Da. The High mass accuracy tolerance can 
be defined in the server configuration tab of the Administration workspace. 

9. Min score threshold : this value limits scoring results to those having a score 
above this threshold. 

10. Min # of peaks matches : this value set the minimal number of MS signals to 
be paired in a match between an experimental and a library spectrum. This 
implies that the scoring engine only considers matches that show this 
minimum number of shared m/z values. 

11. Libraries : Select one or more libraries to be searched. Drag and drop libraries 
from the Available library box to the Selected library box. 
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Note: to select a library, drag its name from the “Available library” list and drop it in 
the “Selected library” list. 

 

Server Configuration 

The server configuration is the part of the administration workspace that allows setting server 
variables:  

- Default profile: a default analysis profile for the server. This profile will be used if a newly 
created user has no personal default profile. 

- Tolerance in high mass accuracy scoring [Da]: the default tolerance value to consider to 
match peaks in fragmentation spectra for the High mass accuracy scoring 
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Note: default profiles are used in certain integration processes. Typically, they are 
used to ensure the use of a unique profile throughout technicians of a laboratory. 

 

License configuration 

 The license configuration is the part of the administration workspace that is used to to obtain 
information about the currently used license or to renew it.  

The About tab shows : 

- The current version number of SmileMS, 
- A link to the license agreement, 
- General information and copyright about GeneBio. 

 

 
 

The License information tab shows: 
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- The Host id of the computer on which SmileMS is installed: this number is 
required for all interaction with GeneBio and the customer support, 

- An option to renew a license, 
- A summary of the license scope. 

 

 
 

How to renew a license? 

You need to renew a SmileMS license to continue to use SmileMS after the trial period is 
expired, or to install a permanent license if you have purchased SmileMS.  

You need to contact GeneBio and provide your Host id. You will receive an email that includes a 
license (.lic) file.  

Once you have received and saved your .lic file on your computer, simply click on Upload file 
and select your newly saved .lic file. This automatically renews your current SmileMS 
license.  

Automate submission to SmileMS or integrate with their party 
software using the SmileMS submission module 

The SmileMS submission module is a separate piece of software that allows to: 
a) Perform submission to SmileMS in a command line mode 
b) Configure an automatic submission to SmileMS at the end of a MS analysis on 

Thermo Fischer instruments via Xcalibur 
c) Allow an integrated solution with Bruker amaZon instrument control 

This module interact with SmileMS via a web protocol and can be installed either on a 
computer where SmileMS is also installed on a computer that is remote and can 
access SmileMS via the web. 

 
If you are interested to install and use the SmileMS submission module, please contact us 

at smilems@genebio.com 
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Backup / restore SmileMS 

It is possible to backup the full content of SmileMS for archiving purposes and restore it later if 
needed. 

How to Backup the content of SmileMS 

The procedure to backup SmileMS 

- On the SmileMS computer create a directory where you want to store a SmileMS backup.  

- Copy the content of the C:\Program Files\SmileMS\backup directory (or where SmileMS is 
installed) in this newly created directory.  

- Go to this directory and double-click on the sms_backup.bat file 

What happens during a backup procedure? 

SmileMS is stopped, a subdirectory is created, the sms_restore.bat script is copied in this 
subdirectory, a dump of the SmileMS database is created and all of the data directories 
are also copied in this subdirectory. Then SmileMS is started again. 

How to Restore the content of SmileMS from a backup 

The procedure to restore the content of a backup  

- Go to the directory containing a SmileMS backup. 

- Double-click on the sms_restore.bat file. 

What happens during a restore procedure? 

SmileMS is stopped, all data, libraries, user definitions, profiles, etc. from the active 
SmileMS are deleted and replaced by the information on the backup. Then SmileMS 
is started again. 
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What’s new, release notes 

Here are summaries of new features and main corrections. 

Version 1.2.3 

- Full support for high mass accuracy instrumentation using a high mass accuracy 
scoring 

- Improved performances for the chromatograms and spectrum viewer 
- Filters for MS level and polarity  
- Bug fixed to handle spectra with no precursors information, with negative m/z and 

intensities 

Version 1.1.26 

- Support for Windows Vista and Windows seven 32 bits. 
- SmileMS works with all Latin characters OS. 
- Backup-restore procedure: the functionality is available in the installation package. 
- Support of raw and processed data improved (handle spectra without precursor 

m/z, with negative intensities, with negative m/z, with no peaks). 
- Analysis and profiles: added filters for polarity and msLevel. 
- Analysis list: improved speed of job list if a lot of jobs available. 
- Analysis list: improved search functionality. 
- PDF exports improved. 
- Time out better handled. 
- Library parsers more efficient and bug fixed. 
- Fixed: double login required in some installations and after time out. 
- Automation of submission to SmileMS from Xcalibur software via the SmileMS 

submission module. 

Version 1.1 

- Spectral and compound level parameters are extended. Support for polarity, 
precursor m/z, msLevel, CAS numbers, Synonyms. Library parsers adapted. 

- Analysis list page: added Owner column. 
- Analysis performances: improved handling of memory during identification and 

library creation. 
- Results,Table of compounds: added a polarity-msLevel column for both Ref and Exp 

spectra. 
- Results, Additional matches tab: fixed missing hits when m/z filters inactive. 
- Library list and details pages: improved 
- Library: possibility to “delete” a spectrum from a library. 
- Library: opening details on a library is accelerated. 
- Library: allow the creation of a library from a mzXML file. 
- Administration: owner column added in Profile manager page. 
- Administration, profile manager: added checkboxes to activate/inactivate RT and 

m/z filters; profiles with no library not allowed. 
- Administration: possibility to define a default format and default profile for each 

user. 
- Administration: fixed errors of license management. 
- PDF exports improved. 
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Patch 1.0.284 

- fixed: AB SCIEX (Analyst) .mdb formatted libraries having entries with no spectra 
failed to install 

Patch 1.0.283 

- fixed: extended demo license demo sometimes not validated 

Patch 1.0.282 

- fixed: bug for unsorted m/z in .mdb libraries 
- fixed: parsing of mzXML where intensities are in scientific writing 
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